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Access to Students in the SESIS Service Capture Calendar  

1. Q: To which students will I have access in the SESIS Service Capture calendar?  
A: You will have access to students for whom you have called in a first attend in IVR. Additionally, in some cases, 
supervisors are able to provide access to a student. All students to whom you have access are listed in the My 
Student Caseload area of your SESIS homepage. 
 

2. Q: I work in multiple schools. Will access to students in different schools also be provided in the Service Capture 
calendar?  
A: Yes. Providers will have access to students from any school following their first attend in IVR, or when access is 
provided to the student by their supervisor.  
 

3. Q: The student membership of my group session does not change from session to session. Is there a way for me 
to permanently identify this set of students as my group in order to expedite input of their group Service 
Records? 
A: Yes. On your homepage scroll to your Student Caseload, click Edit, and click New Caseload Group on the 
Actions toolbar. Input a Group Name, select from your caseload students those to be included in the group and 
click Accept. When you next display your Services Calendar, select your new group name from the Filter drop-
down list at the top left of the screen, click Select All to highlight all of the student names and then continue to 
record the completed session or schedule a future one.  
 

4. Q: Am I allowed to add my non-mandated students to my Caseload?  
A: You should only add students to your Caseload if a mandate exists for them and you have permission to 
provide service.  
 

5. Q: Are non-public, charter, private, parochial or Pre-K student attendance to be recorded in SESIS? 
A: No, continue with the paper-based process.  
 

6. Q: I am a school nurse. Do I record attendance in SESIS?  
A: Nurses will record attendance in hardcopy form or, for schools which have access, in the Automated Student 
Health Records (ASHR) system. 
 

Recording Past Service in the Services Calendar  
7. Q: Can I add activities not related to encounter attendance on the Service Capture calendar?  

A: No. The calendar is designed for service capture using the pre-formatted Service Record form. The calendar is 
not intended to document non-service related activities.  
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8. Q: Is there a way for me to copy and paste one Service Record into another to expedite my input? 

A: Yes. From your SESIS homepage click Personal Options/Content then click Set My User Options. In the dialog 
box that displays click the checkbox beside “With service capture, use last service record of student as default 
values for next one.” The next time you create a Service Record for any student, SESIS will replicate data from the 
previous Service Record for that student into the new Service Record.  
 

9. Q: Can I delete a recorded past session for one of my students?  
A: Yes. You can delete past (or future) services. To delete a session open the Service Record from the Services 
Calendar and choose the Delete link from the Actions: toolbar.  

10. Q: Can I record multiple sessions for the same student on the same day?  
A: Yes. You can record more than one session for the same student on the same day; however, the sessions may 
not overlap.  

11. Q: Can I record multiple Service Records at one time? 
A: Yes, you can input multiple individual sessions for a student or multiple group sessions for the same group of 
students. From within the Services Calendar, select the students from your caseload listed on the left, click Record 
Past Services or Schedule Future Services, then click on each of the dates you saw (or will) see them. Click Save 
when you’ve completed input of all pertinent information for each child. 
 
When multiple dates are selected, SESIS provides a new screen for you to type in all information you want 
repeated on the Service Record for each of the selected dates. Information you input in the “common 
information” screen will be automatically pre-populated in the same fields on each individual student Service 
Record.  
 

12. Q: How do I record a split mandate (both individual and group mandates) for a student?  
A: Complete separate Service Records for both the individual and group sessions on the dates and times when 
they occurred. To differentiate between the two, the Service Record form allows the provider to select 
“Individual” or “Group” in the Group Size field.  

13. Q: Am I required to certify past services?  
A: Yes. Service Records for past services that are not certified are incomplete and will not appear on the 
Encounter Attendance reports.  

14. Q: Do I certify the session whether I see the student or not?  
A: Yes. All past sessions must be certified. 

15. Q: Can I print my encounter attendance calendar or individual sessions for my own records?  
A: Yes. You can print individual sessions. You can also print the Services Calendar using the monthly, weekly or 
daily view; however, you may need to adjust your printer settings using Page Setup from the File menu. 
Additionally, you can print reports of completed services.  

Recording Session Notes  
16. Q: Are Session Notes specifically required to complete a past service?  

A: Yes, with the following exceptions: ESL teachers, SETSS teachers, and Paraprofessionals. If you have further 
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questions regarding Session Notes, please reach out to your supervisor.  
 

17. Medicaid guidelines require that session notes be contemporaneous with the service. Does SESIS provide for 
this? 
A: Yes. You should type your session notes and certify the Service Record, as soon as possible after you have 
delivered the service. 

18. Q: Is there a time limit to input and certify Session Notes?  
A: Yes. You must certify Service Records before the end of the 15th day of the month following the session with 
the student. For example, if a session was held on June 22nd, you must certify the Service Record by July 15th.  

19. Q: Does SESIS provide access to the provider’s Session Notes once the new school year begins?  
A: Yes.  

20. Q: How do I record Session Notes for a group session?  
A: As is current practice, you must complete Session Notes for each individual student’s participation in the group 
setting. In SESIS, these notes must be recorded on the Service Record for each individual student.  

21. Q: Should Social Workers, Guidance Counselors, and Psychologists who provide counseling enter Session Notes?   
A: Yes. If notes are stored elsewhere due to privacy concerns, Social Workers, Guidance Counselors, and 
Psychologists who provide counseling services should indicate in the Session Notes where their detailed notes on 
the session are located (e.g. hardcopy, file, other digital record, etc.). 
 

22. Q: How long will SESIS keep the Session Notes?  
A: Encounter attendance Service Records, including Session Notes, are permanent archives of the student’s file on 
SESIS and are maintained indefinitely.  

23. Q: Can other providers see my (provider's) Session Notes?  
A: All providers with access to the same student can see the certified Session Notes associated with that student.  

24. Q: How can I see a running attendance log and Session Notes? 
A: From the Services Calendar, select the student, click Reports… and select the Services Completed for Student 
report. Click Services Listing from the View toolbar to see the detail of certified services provided to the student. 
 

Recording Group Size  
25. Q: Do I enter the actual Group Size, or mandated Group Size when recording a past service?   

A: When recording a service for students who were present at the session, you must record the actual number of 
students in the session.  For instructions on recording student absences or session cancellations, please see the 
FAQ section called “Recording Absences and Cancellations”. 

 
26. Q: Some IEPs do not indicate a Group Size in the mandate.  What do I enter in Encounter Attendance?   

A: The IEP group size is only recorded when recording an absence or cancellation. If there is no group size, you 
should record attendance as the default group size of 8.  The IEP should be amended to specify an appropriate 
group size.  If the group size changes from 8 as a result of the IEP amendment, enter the new group size going 
forward. 
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27. Q: How do I record attendance for a group session where only one participant was present?  
A: You should indicate the Group Size as “Group” and select a value “1” from the associated dropdown menu. 
Document the absent students as directed above. 
 

28. Q: ESL groups are allowed up to 12 students per group, but SESIS limits groups to eight. How do I indicate a 
group size larger than eight?  
A: Record a group size of 8 in the group size field and indicate the correct group size in Session Notes. 
 

Recording Absences and Cancellations  
29. Q: What constitutes a student absence? 

A: A student is considered absent from a scheduled session when the student does not attend school that day, or 
when present at school, refuses to attend the scheduled session. 

30. Q: How do I record a student absence?  
A:  When completing the Service Record, select the Session Type “Student Absent”. You should record the 
planned duration of the session in the Start Time and End Time fields. You don’t have to record Service Location, 
Service Description, Progress Indicator and Session Notes; however, it is best practice to document in Session 
Notes why the student was not available, if known. You must certify all absences. 
 
For students absent from a group session, you will enter the group size as indicated on the IEP and the time the 
session was held for the rest of the group.  You don’t have to record Service Location, Service Description, 
Progress Indicator and Session Notes, it is best practice to document in Session Notes why the student was not 
available, if known. You must certify all absences. 

31. Q: How do I document a student’s long term absence?  
A:  Remove the student from your Caseload. When the student returns, call the first attend into the IVR system 
again. 

32. Q: What constitutes a provider absence? 
A: You should record a session as “Provider Absence” when a session was scheduled but you were absent from 
the DOE. Examples of this would be when a provider takes personal leave time or calls in sick. 

  
33. Q: How do I record the absence of a provider?  

A:  When completing the Service Record, select the Session Type “Provider Absent”. You should record the 
planned duration of the session in the Start Time and End Time fields. You don’t have to record Service Location, 
Service Description, Progress Indicator and Session Notes; however, it is best practice to document in Session 
Notes the reason for the absence. You must certify all absences. 
 
For a group session, you will enter the group size as indicated on the IEP and the time you planned to hold the 
session.  You don’t have to record Service Location, Service Description, Progress Indicator and Session Notes; 
however, it is best practice to document in Session Notes the reason for the absence. You must certify all 
absences. 

34. Q: What constitutes a cancelled session? 
A: A session should be recorded as cancelled when the session is not held due to reasons other than student or 
provider absences as described above. Examples of cancelled sessions would include, but are not limited to, 
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school closings (e.g. snow days) the provider is attending an IEP or other school based meeting, DOE-approved 
training (e.g. conference or professional development day during school hours that is not on the official DOE 
calendar); or asked to perform another task; or if the student is in school but is unavailable (e.g. school assembly, 
testing, school trip, etc.). 

35. Q: How do I record a cancellation?  
A:  When completing the Service Record, select the Session Type “Cancelled”. You should record the planned 
duration of the session in the Start Time and End Time fields. You don’t have to record Service Location, Service 
Description and Progress Indicator. You should document in Session Notes the reason for the cancellation. You 
must certify all cancellations. 
 
For cancelled group sessions, enter the group size as indicated on the IEP and the time you planned to hold the 
session. You don’t have to record Service Location, Group Size, Service Description and Progress Indicator. You 
should document in Session Notes the reason for the cancellation. You must certify all cancellations.  

Completing the Past Service Record  
36. Q: How do I indicate a change in the session (e.g. if the student is late)?  

A: You must document the session exactly as it occurred including a change in date, time, service delivered, etc. 
Feel free to document the reason for the change in the Session Notes.  

37. Q: What do I enter if the session runs longer than scheduled?  
A: You should record the planned start and end times.  
 

38. Q: What Service Description must an Occupational Therapist or a Physical Therapist choose when providing 
group therapy to a group of 2 or more students? 
A: When providing OT or PT group therapy to 2 or more students at the same time, OT and PT providers must use 
the service description “Group Therapy Procedure –CPT Code 97150” only. 
 

39. Q: To what goals is the Progress Indicator referring?  
A: The Progress Indicator refers to the annual goals on the student’s IEP. 
 

40. Q: I am a paraprofessional who provides a specific service to a student three times per day.  How do I enter 
attendance for these students?   
A: You must record each session of the day individually. 
 

41. Q: Does Encounter Attendance meet Medicaid requirements?  
A: Yes. 

 
42. Q: Must I follow Medicaid rules stating that each service provision must have at least 15 minutes allocated to it?    

A:  You should include all the activities that you performed during that session.  If Medicaid reimbursement for 
that service has a time-based constraint, SESIS will limit the number of activities you can report.  
 
Note: Occupational Therapists and Physical Therapists should choose treatment codes that lasted 8 or more 
minutes. For example, if in a 30 minute session, a PT provided “Gait Training” for 15 minutes, “Strength Training” 
for 9 minutes and “Sensory Processing Activities” for 6 minutes, the Physical Therapist must click “Gait Training” 
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and “Strength Training” service descriptions. 
 

43. Q: When completing a Speech-Language Therapy Service Record, SESIS displays a workflow prompt that 
reiterates the need for a Speech-Language Referral document for the calendar year. Where is this located in 
SESIS?  
A: Speech Providers should go to the Documents section of the student’s online record and click the Create New 
Document dropdown menu. The Speech Referral document is listed under the Related Services heading. When 
your input is complete, you must finalize the document by clicking on the More Actions link and selecting Change 
Status of This Document. This will change the document status from “Draft” to “Final”. 
 

44. Q: How do I access the documents of the student’s online record so as to create a Speech-Language Referral?   

A: Scroll down to the Student Caseload on your homepage and click the blue arrow to the left of the student’s 

name. Select Student Documents from the list. 

Scheduling Future Service in the Services Calendar  
45. Q: Can I schedule back-to-back concurrent sessions on the calendar?  

A: Yes.  

46. Q: Can I schedule all of my student sessions for the school year?  
A: Yes. You can schedule future services for the entire school year, but you can only schedule them two months at 
a time.  

47. Q: Can other providers see my scheduled future sessions on the Services Calendar?  
A: No. Other service providers with access to the student can only see certified Service Records; consequently, you 
should collaborate with other service providers to ensure there are no conflicts in sessions that have not yet 
occurred.  

48. Q: Can I delete a scheduled session?  
A: Yes. Open the Service Record, click Delete from the Actions toolbar, click Delete Service Record and click OK. 

49. Q: Can I copy my weekly/monthly schedule to future weeks/months?  
A: No.  

50. Q: Can I see if my student already has a scheduled session with another provider?  
A: No. Future sessions of service providers may only be viewed by the provider who recorded them.  

51. Q: How do I move a scheduled session from one day to another?  
A: From the Services Calendar double-click on the scheduled future session placeholder icon to open the Service 
Record, change the date and click Save. If you are already viewing the Service Record, click Edit from the Actions 
toolbar, change the date and click Save.  
 

Encounter Attendance for Related Service Provider Supervisors 
52. Q: As a Related Service Provider Supervisor, how can I see the provider’s caseload? 

A: Search for the provider using the Staff Quick Search form from the SESIS homepage. In the search results 
screen that displays, click the magnifying glass in the left margin to open the provider’s Profile. Choose Caseload 
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from the drop-down list located in the Select menu. 
 

53. Q: Can I view the Service Records of a student? 
A: Yes. Search for the provider using the Staff Quick Search form from the SESIS Home Page. In the search results 
screen that displays, click the magnifying glass in the left margin to open the provider’s Profile. Choose Service 
Records from the drop-down list located at the Select menu. 
 

54. Q: How do I add a student to the provider’s Caseload, when needed? 
A: Search for the provider using the Staff Quick Search form from the SESIS homepage. In the search results 
screen that displays, click the magnifying glass in the left margin to open the provider’s Profile. Choose Caseload 
from the drop-down list located at the Select menu. Click Add Students from the toolbar to search for the 
student; click Add Students Marked Above to Standard Caseload to assign the student to the provider. 

 


